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CONSOLE is a software that enables you to adjust the settings of a camcorder from #
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a computer and to record on the tape in the camcorder and onto the computer’s

hard disk by connecting the camcorder using an IEEE1394 (DV) cable. You can

adjust and save the Custom Preset settings of the camcorder and analyze a Troubleshooting Shortcut Keys
shooting image using a waveform monitor and a vector scope to compose the

image you want.

This software is for use with Windows® XP (Service Pack 2) only. English
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B Disclaimer

o While every effort has been made to ensure that the information contained in this guide is accurate
and complete, no liability can be accepted for any errors or omissions. Canon reserves the right to
change the specifications of the hardware and software described herein at any time without prior
notice.

O No part of this guide may be reproduced, transmitted, transcribed, stored in a retrieval system, or
translated into any other language in any form, by any means, without the prior written permission
of Canon.

o Canon makes no warranties for damages resulting from corrupted or lost data due to mistaken
operation or malfunction of the camcorder, the software, personal computer, or peripheral devices.

B Trademark Acknowledgements

o Microsoft® and Windows® are either registered trademarks or trademarks of Microsoft Corporation
in the United States and/or other countries.

o Other names and products not mentioned above may be registered trademarks or trademarks of
their respective companies.

o Avid® and Avid Xpress® are either registered trademarks or trademarks of Avid Technology
Incorporated.

© Canon Inc. 2005 All rights reserved.

Canon camcorder compatible with CONSOLE

Following camcorder can be used with CONSOLE.
XL2* \ XL H1 |

*Unable to use some functions

Required Accessories

o Canon digital camcorder compatible with CONSOLE
0o |IEEE1394 (DV) Cable
Check the manual of your computer for which type of cable to use:

4-pin: T — 6-pin: 4.5

System Requirements

(O] Microsoft Windows XP Home Edition or Professional®
(Installation of Service Pack 2 required)
Proper operation is not guaranteed on Windows XP that has been upgraded
from a previous version.

CPU » Pentium M 1.5GHz or better
* Pentium 4 2GHz or better (Pentium 4 3.2GHz or better recommended)

RAM 512 MB or more (1 GB or more recommended)
Free Hard Disk For installation
Space Free Hard Disk Space: 30 MB or more
For video recording
Free Hard Disk Space: 1 GB or more
File System: NTFS
Recordings cannot be made on FAT32 or FAT16 formatted hard disks.
Display 1024 x 768 or more required
Full Color (32bit) required
Sound Windows XP compatible sound system
Interface IEEE1394 (OHCI compliant)

*The software cannot be operated on Windows XP Professional x64 Edition.

O Proper operation is guaranteed only when you are running CONSOLE on Windows XP
@ Home Edition (SP2) or Professional (SP2) English, French, Spanish, German, Italian or
Simplified Chinese versions. Proper operation is not guaranteed if the OS you are using
operates in a different language.

O Proper operation is not guaranteed on a dual CPU PC or on a user-built PC.

O Proper operation is not guaranteed on any particular system, even if it meets the
requirements outlined above.

O If you set the video folder to an external hard disk, an error message "Delayed Write Failed"
may be displayed while recording onto the hard disk, and the recording may be lost.

O Recordings cannot be saved on a hard disk recognized as [Removable disk].

Q If you connect 4 or more devices (including the connected computer and the XL H1 itself) by
IEEE1394, CONSOLE will not run properly.

- Proper operation cannot be guaranteed if you are using a repeater.

O If your computer has an IEEE1394 (DV) board/card in addition to the standard IEEE1394
(DV) board/card, or if you have several IEEE1394 (DV) boards/cards added to the
computer, the computer may not recognize the camcorder properly. In such case, see
Camcorder will not be recognized or controlled. ([11 Tr-1)

O This software will not operate properly if more than one camcorder is connected to the
computer.

O Depending on the setting of the power scheme of the laptop PC, the preview images may
not be played back smoothly. Select [Always On] in the [Power Options Properties] window.
(M Tr-2)

o When the computer enters stand-by mode or hangs up while running CONSOLE, proper
operation is not guaranteed after recovering.
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O This software supports both HDV and DV standard recordings. To edit a file recorded in
HDV, use editing software that supports the HDV standard.

O This software can also be used with the recordings in 24F (NTSC only). Use an editing
software that supports the 24F frame rate.

B What is CONSOLE?

CONSOLE is a software that enables you to adjust the settings of a camcorder from a computer and

to record on the tape in the camcorder and onto the computer’s hard disk by connecting the

camcorder using an IEEE1394 (DV) cable. You can adjust and save the Custom Preset settings of the

camcorder and analyze a shooting image using a waveform monitor and a vector scope to compose

the image you want.

With CONSOLE you will be able to:

» Record the camcorder image onto the computer’s hard disk.

* Output the image recorded on the hard disk to a monitor via the camcorder.

* Adjust the camcorder’s settings (Custom Preset) and save them on the computer’s hard disk.

» Analyze the image using a waveform monitor and a vector scope.

» Compare the camcorder image and the recorded image by simultaneously displaying both images in
the same window.

« Display a safety zone marker, an aspect marker and several other markers on the window and
create new markers.

* Perform the cache and frame recording.

B Functional Comparison

The functions available differ depending on the connected camcorder and the camcorder mode.

« EXT.CONT. mode (£ ): This mode is available for remotely controlling the camcorder. When the
camcorder is set to EXT.CONT. mode, only the following functions of the camcorder can be used.
- Camcorder’s start/stop button
- Handle and grip zoom lever
- ZOOM SPEED switch and dial
- EJECT switch
- All audio related adjustments except for AUDIO MONITOR button

+ Cameramode ((A] Tv Av M & []): This mode is available for directly controlling the
camcorder.

- Some functions of CONSOLE cannot be used.

« VCR/PLAY mode (¥& ): This mode is available to playback or output the picture recorded on the
tape.

- You do not use this mode when you connect the camcorder to the computer.

Camcorder XL H1 XL2
Mode EXT.CONT.| Camera |EXT.CONT.| Camera
Custom Preset Settings o o) o) x
Saving the Custom Preset on the camcorder o x o) x
Saving the Custom Preset on the memory card o x x x
ﬁ:x;ncﬂ;:e Custom Preset on the computer’s o o o .
Camera Control tab o} x o} x
Image output ¢) x o) x
Copying files from the memory card o x x x
HDV recording o) o) x x
DV recording o o o) o)

B Limitations During the Trial Period

During the trial period, you can start CONSOLE 50 times limited to within 14 days. During the trial
period, the following limitations apply to CONSOLE.

* You can operate CONSOLE for 120 minutes only.

* You can record for 5 minutes only.

* You cannot save or load Custom Preset files.
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Installing the Software and the Designated Drivers

®

o Do not connect the camcorder to the computer when installing the software.
O You need to log in as an administrator before installing the software.

O Close all programs that are running before installing the software.

Canon Utilities CONSOLE 1.0

Canon Utilities CONSOLE 1.0

The InstalShield® ‘wizard will install Canon Utiities
CONSOLE 1.0 on your computer. To continue, click Next,

Choose Destination Location

Select folder where Setup will install files

Setup will install Canon Ltiliies CONSOLE 1.0 in the following folder.

another fiolder

Destination Folder

C:\Program Files'Canon

‘h

Tovinstall to this folder, click Next. To instal to a differert folder, click Browse and select

Browse.

<Back Cancel

Start the CONSOLE installer and
click [Next].

Confirm the target folder and
click [Next].

If a dialog appears asking you whether you
wish to create a shortcut for CONSOLE,
click [Yes].

4

Canon Utilities CONSOLE 1.0
InstallShield Wizard Complete

Click Finish to launch CONSOLE.

when application is launched fistfime, a virtual device of
“Canon Virtual VCR or "EW/C T ape RecorderFlayer” wil be
deterted and "Found New Hardware Wizard" wil appear. The
virtual device is necessary for CONSOLE to work. Please
select "Install the software sutomaticall (Recommendsd)” and
ntall a chiver for the device:

Found New Hardware Wizard

‘Welcome to the Found New
Hardware Wizard

“Windows will search for current and updated saftware by

looking an your computer, on the hardware instaletion C0, or an
the Windows Update Ww=b site (with your permission)

Bead our privacy policy

Can Wwindows comnect to windows Update to ssarch for
software?

() Yes, this time only
(O asezzad suary line | connect a device
@ Mo, not this fime

Click Next to continue.

Found New Hardware Wizard

This wizard helps you instal software for

Canon Yirtual ¥R

() 1f your hardware cams with an installation GO
&2 or floppy disk, insert it now.

wihat da you want the wizard to do?

() nstall the software automatically [Hecommended}

O T

oimosibin ooy
" =]

Click Mext b continue.

<Back ([_mew> D Cancel

Click [Finish].

If a warning window concerning the
installation is displayed, click [Continue].
The dedicated driver will be installed
automatically.

Select [No, not this time] and
click [Next].

Select [Install the software
automatically (Recommended)]
and click [Next].

If a warning message regarding the
installation appears, click [Continue

Anyway].
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»
Installing the AV/C Camera Storage
Subunit-WIA Driver

The AV/C Camera Storage Subunit-WIA driver is used for downloading and uploading the Custom
Preset file (Camcorder settings) from and to the camcorder. When installing the AV/C Camera
Storage Subunit-WIA driver, you need to connect the camcorder to the computer. Refer to Connecting

Click [Finish].

Found New Hardware Wizard
Completing the Found New

Hardware Wizard
The wizard has finished instaling the software for
the Camcorder to the Computer ([11 1-3).
o Without Installing the AV/C Camera Storage Subunit-WIA driver, you cannot adjust the

@ Custom Preset settings.

O You need to log in as an administrator before installing the software.
O Close all programs that are running before installing CONSOLE.
O Do not turn the camcorder’s power off and do not quit the driver’s installation before

Canon Wittual VCR

completing the installation of the driver.
Turn the camcorder’s power on and activate the DV CONTROL

Click Firish to close the wizard,

1

function.
Set the camcorder’s recording program to EXT.CONT.

Connect the camcorder to the computer using the IEEE1394 (DV)

cable. ((101-3)
« For details about connecting the camcorder to the computer, refer to Connecting the

Camcorder to the Computer ([111-3).

* When the [Found New Hardware Wizard] window appears, select [No, not this time] and
click [Next]. In the next window, select [Install the software automatically (Recommended)]
and click [Next].

- If a warning message regarding the installation appears, click [Continue Anyway].
« Installation of the driver starts automatically.
» Depending on the setting of the computer, an editing software may be launched. If this

happens, close the software.

« After completing the installation, [Scanner and Camera Wizard] or a window asking you to
choose the software may be displayed. Click [Cancel] and close the window.
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Check if the driver has been

installed correctly. Connecting the Camcorder

Connecting the Camcorder to the Computer

1 Turn the camcorder’s power on and activate the DV CONTROL

function.
FET 2 Set the camcorder’s recording program to EXT.CONT. or Camera
mode.
Open [My Computer] and check if the [Canon Camera Storage Device] icon appears. If the * When the camcorder is set to EXT.CONT. mode, only the following functions of the
icon does not appear, the installation has not been completed properly. Uninstall ([I] 7-1) and camcorder can be used.
reinstall the driver. - Camcorder’s start/stop button

- Handle and grip zoom lever

- ZOOM SPEED switch and dial

- EJECT switch

- All audio related adjustments except for AUDIO MONITOR button

3  Connect the camcorder to the computer using the IEEE1394 (DV)
cable.
* You do not need to turn off the computer.
» Do not deactivate the DV CONTROL function while the camcorder is connected to the
computer.
« Refer to the computer manual for the location of the computer’s IEEE1394 (DV) port.

| |

DV cable

HDV/DV terminal --15) ke e

k(== iy~ IEEE1394 port
el P
on the camcorder

on the computer

* When tbe camcorder is correctly connected to the computer, depending on the camcorder
mode, (@ (Camcorder icon) and @ (Camera icon) appear under [My Computer].

e Edt VYew Favorkes Joos bep

Y O sewcn Folders | 771+

Files Stored on This Computer

= o

Hard Disk Drives

2]
2 addorr ograms
B | S P ok @) g Loca vk (0)
3
e o
Det

aaaaaaaaaa
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Launching CONSOLE

Changing the Software Event Setting

When using CONSOLE, you need to deactivate the Windows program that automatically prompts you
to choose an application when you connect the camcorder to the computer (set to “Take no action”).

1 Set the camcorder’s recording program to EXT.CONT. or Camera
mode. ([0 1-3)

2

Right-click on [Canon Camera

Ble Edt Vew Favortes Tods Heb

3| Do i e | - Storage Device] icon in the [My
EEERE| B v c v B .
| rsstontn Computer] window and choose
(] shretoscmens ([ eesstocmes [PropertieS].
'vmamgk(c) Van k(D)

Select [Take no action] under
[Device Connected] in the
[Events] tab and click [OK].

Canon Camera Storage Device #2 Properties

General | Events | Color Management

Selectangvent: | S (TR — vl

Aitions

Choogs an event below, then select the action to take when that
event occurs.

(O Start this program: =58

() Take no action

() Save all pictures to this folder

—

Starting the Application

@

O You need to log in as an administrator before installing the software.

o Do not change the user account while running CONSOLE.

o If you are running software that displays the time at the title bar, the title bar may not display
texts properly.

O Do not change the settings in Windows [Display Properties] window while launching
CONSOLE.

Double-click the [CONSOLE] icon on the desktop.

* When you have not registered the license yet, the remaining trial period and number of
times you can start CONSOLE are displayed. Click on [Registration] when you proceed to
register the license.

* When the trial period is expired, or the number of times you can start the CONSOLE is
exceeded its limit, a warning window appears. Click on [Registration] and proceed to
register the license. ([11 1-5)

Confirm the target folder (video folder) and click [OK].

Confirm Video Folder

Click [Modify Folder] to change
the target folder.

By removing this checkmark, this
window will not appear next time
you start CONSOLE.

The first time you start CONSOLE, the target folder is set as [Windows drive:\Documents and
Settings\login user name\My Documents\CONSOLE\date]. If Windows is not installed on an
NTFS formatted hard disk, the following dialog appears. Click [Specify] and select a folder on
an NTFS formatted hard disk.

Video Folder setting

If you set the video folder to an external hard disk, an error message “Delayed Write
Failed” may be displayed while recording onto the hard disk, and the recording may
be lost.
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—

Activation

You can use all of the functions of this software after registering the license key. During the trial
period, you can start CONSOLE 50 times limited to within 14 days.
During the trial period, the following limitat1ions apply to CONSOLE.

- You can operate CONSOLE for 120 minutes only.

- You can record for 5 minutes only.

- You cannot save or load Custom Preset files.

Purchasing the License Key
For details about purchasing and receiving the license key, please visit the Canon’s download site.

1 Setthe camcorder’s recording program to EXT.CONT. or Camera mode
and connect the camcorder to the computer. ([1]11-3)

2 start CONSOLE.

3 Click [Registration] in the trial confirmation window.
If you are already running the software, select [Version] » [Version] » [Registration].

4 Read the license agreement and note the product ID.

If an appropriate camcorder is not connected to the computer, the product ID will not be
displayed.

5 Enterthe product key and necessary information on the license
purchase site.
For details, visit the Canon’s download site.

6 Receive the license key.

Registering the License Key

1 Setthe camcorder’s recording program to EXT.CONT. or Camera mode
and connect the camcorder to the computer. ([1]11-3)
Connect the same camcorder as the one used for receiving the license key.

2 Start CONSOLE.

3 Click [Registration] in the trial confirmation window.

When you are in the trial mode and you are already running CONSOLE, select
[Version] » [Version] » [Registration].

4

Read the license agreement and confirm the product ID.
If the product ID is not the same as the one for receiving the license key, you cannot register
the license.

Enter the license key and a user name.

Read the license agreement, and click [YES].
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CONSOLE Windows

Main Panel

.................................................................................................................................................... 2-1
=T 11 = 7= | PSP 2-1
(07T g pTelo] (o [T RS ¢= | (1 1 PP PPSURRR 2-2
oL | o 7= RSP 2-2

Workspace

Camcorder Screen
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CONSOLE Windows

S—

Main Panel
1

Fie(®) View(®) Versond |

6 —JEE * 6 T=E+E o]
@

DT [ Opty e

@ |Rec Viewer (22%) @ ||Pray viewer (22%)

|| o | |

1 Menu
2 [Play Panel]

For details, refer to Menu Bar ([1]2-1).

Displays [Play Viewer] ([116-1), [File Browser] ([116-3) and a
Waveform Vector Monitor ([114-10).

3 Camcorder Information Shows the camcorder model name and the status of the tape in the
camcorder. For details, refer to Camcorder Status ([112-2).

Displays the status of the software.

Displays [Rec Viewer] ([I14-1), [Focus Assist] ([114-6), [Camera
Control] ([(114-6), a Waveform Vector Monitor ([114-10) and [Custom

Preset] ([114-11).
For details, refer to Toolbar ([112-2).

4 Software Status
5 [Rec Panel]

6 Toolbar

@ Select [Exit] from the [File] menu to end the application.
"

Menu Bar

H [File] Menu

1
2

File{F)
Cpkionfoy,,, ——— 1
Exit{®) ——— 2

Displays the [Option] window ([113-1).
Closes CONSOLE.

H [View] Menu

A ON =

Toolbars{T) b—> | » Main Toolbar(M)

v Rec Toolbar(R)

v Flay Toolbar(P)

Rec PanellR) F
Flay Panel(P) b\

Wark Space(W) > W Main Window() Chrl+R
v Rer Yiewer(D Chrl+y
W Camera Conkrol{C) Chrl+C

v Weckor and Wave Monitory)  Chrl+H

W Foous fssishF) Ckrl+F
v Custom Preset(l Zhrl+I
W Main Window() Ckrl+P
v Flay Viewer(D) Chrl+D
v File Browser(E) Chrl+E

W Weckor and Wave Monitory)  Chrl+w

add Wwark spacela)...
Delete Work Space(D). ..

WorkSpacel
WorkSpaces

Displays/Hides the toolbar ([112-2).
Displays/Hides [Rec Panel] and the recording tools.
Displays/Hides [Play Panel] and the playback tools.

Adds/Deletes the workspace ([112-3).
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CONSOLE Windows

—

B [Version] Menu H Main Toolbar

Mersion(T)

About COMSOLE(A),,, ——— 1

1 2 3 4
1 Displays the version and the license information. | E | E | # e

Displays/Hides [Rec Panel].
Displays/Hides [Play Panel].

Displays the [Option] window ([113-1).
Displays the version information.

Camcorder Status
This status shows the name of the camcorder connected and status of the tape.

A ON =

Icon Status of the tape

No tape in the camcorder .
P B Recording Toolbar

Stop mode 1 5 3 4 5
Recording | | | |

Tape reached the end _—
e
Tape is write-protected. | E | ﬁl 7 I, | E |

Tape error

l 0 (6 0 61 (B

1 Displays/Hides the [Rec Viewer] window.
Toolbar . . :
2 Displays/Hides the [Camera Control] window.
There are “Main Toolb_ar", “Recording Toolbar” and “I_:’Iayback Toc_)lbar" i_n the main panel. Each toolbar 3  Displays/Hides the waveform vector monitor.
can be displayed or hidden, or moved around (docking and floating) with the mouse. 4 Displays/Hides the [Focus Assist] window.
» Docking * Floating 5 Displays/Hides the [Custom Preset] window.
Main B Playback Toolbar
1 2 3
- E #* 6 ]
Filef{E) View(d) Yersion{l)
oEEXEEECEIERE] 2 Q|
— COMSOLE
El[ A T— File(F)  Wiew{y} | wersion(I)
[ |[Camera Control Rec Viewer (21 =IE ;w;,_;||ﬁ|§|'§_._g|7|i| OICYE] 1 Displays/Hides the [Play Viewer] window.
% [ Infom “antio [ = Rec Panat 2 Displays/Hides the [File Browser] window.
e AESH”:T | WHITE BALANCE T CaiTon Rec Viewer (22%) 3 Displays/Hides the waveform vector monitor.
= = — T —
e Contg 2y Toredisplay the toolbar, select [View] » [Toolbars] and the name of the toolbar you want to
AESHJI:!' | " redisplay.
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Workspace

You can register your own panel layouts to suit the purposes of the projects.

1

Select [View] » [Work Space] »

[ConsoLe
FileiF) B BN Wersion(l) [Add Work Space]'
E [ Toolbars(T) > = EE 4§. E Q
Rec Panel(R) +
[«]Re

Play Pangl{F} r

2 Input the name of the workspace

and click [OK].

The positions of the windows are registered
and the name of the workspace will be
displayed in the menu.

o Up to 10 workspace configurations can be registered. To delete a workspace, select
[View] » [Work Space] » [Delete Work Space].

O To choose the registered workspace, select [View] » [Work Space] and the name of the
registered workspace.

O
@

)
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Camcorder Screen

The CONSOLE status and the remaining recording time on the hard disk are displayed on the
camcorder screen.

HDVBOi

00:53:56:27R
7 min
—]

] e |
MANUAL

1/60

F5. 6

DVZ,®77B6min

CONSOLE Status

Icon
D2 Not started
DV 2! Stop mode
s Recording
DY 2 Data dropping occurred ([1]15-5).
Dy o Cannot record ([T]1Tr-2).

Check the setting of the video folder.

2y ° If [z ] is not displayed, activate the DV CONTROL function of the camcorder.
“Z4l o When the hard disk does not allow recording (e.g. hard disk space is running out), recording
is made only on the tape.
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[Option settings] and [Performance check]

General] Tab
Video Folder and Recording Settings [General] Ta

You need to specify the video folder (a target folder), file name and other settings before you start the
recording the camcorder pictures onto the hard disk.

t’lption Settings

1 Select [Option] from the file
COMNSOLE menu, or click G .

IEEN Wiew(y)  Wersion(
o). SIS
C_osten0).._5 YA
Esib()

=1 e 1 alisi

7\

Custom Preset 2

2 3

BT SeTe Choose one of the tabs, set the .,
option settings and click [OK].

5

6

Apply

1 [Video folder] Shows the selected folder.
[Modify] Selects a different folder.
[Create sub-folder] Creates a subfolder within the folder shown under [Video folder]. You can
name the folder after the date by selecting [Use recording date] or specify
a new folder name under [Specify folder name].

2 Specify the file name of the video recording. A sequence number (up to 9999999) will be
allocated after the specified prefix (e.g.“CNSL0001.avi").

= 3 -« Place a check mark to record the Custom Preset settings of the camcorder onto the hard
disk. CONSOLE only saves the settings of the camcorder when the recoding is started. The
name of the Custom Preset file will be the recording file name, and the extension is “.cpf”.

» When [Sequence] or [Frame] mode is selected in the [DV Rec] tab of the [Option settings]
window, the Custom Preset file will be recorded only when you started the recording.

4 When the camcorder’s sound setting is set to 4ch, channel 3 and 4 sounds will be recorded
separately from the recording file. For example, when “DVPC0001.avi” is recorded,
“DVPC0001_sub.wav” is recorded in video folder.

5 Sets the cache recording time ([115-3).

6 Placing a check mark displays a dialog confirming the video folder each time you start
CONSOLE.




[DV Rec] Tab

This tab is for the DV standard recording settings when you record in DV.

Option Settings

*erfarman o | Apply | Ok, | el

1 Select the recording file type.
Select the AVI type that is compatible with your editing software. You can select the file type
from [AVI-Type1], [AVI-Type2] or [MXF]. For details, refer to the instruction manual of the
software or consult the software manufacturer.

2 Select a mode for recoding onto the hard disk.
[Standard] A new file will be created each time you start recording a new scene.
[Sequence] The new scene will be added to the same file.
[Frame] 1 frame is recorded and added to the same file each time you press the recording
button. ([115-4)

Placing a check mark at [Interval recording] makes CONSOLE to repeatedly
record the frame image at the specified interval time.

o Avid Xpress® can properly read 60i, 30F, 50i or 25F MSF files recorded by CONSOLE; it
@ cannot read 24F MXF files recorded by CONSOLE.
O When recording an [MXF] picture, WAV sound files with the same file name as the recording
file will be saved. The sounds on channel 1 and 2 will be recorded in “File Name.WAV”.
When the audio mode is set to 4CH, the sounds on channel 3 and 4 will be recorded in “File
Name_sub.WAV”. When using the editing software, load all the sound files.
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[Option settings] and [Performance check]

[HDV Rec] Tab

This tab is for the HDV standard recording settings when you record in HDV.

Oplion Settings

General

Apply | ok | Cancel

1 Select the recording file type.
Select the AVI type that is compatible with your editing software. You can select the file type
from [MPEG2TS] or [MPEG2ES]. For details, refer to the instruction manual of the software.

2 Select the [Preview resolution] of the HDV standard data. The size of the recording picture will
not be changed.

3 Select the type of MPEG2 for the picture displayed in the preview. The types of the recording
picture will not be changed.

4 Select whether or not you need to convert the color of the preview image. When the color of
the preview image appears odd, select [OFF].

O When recording an [MPEG2ES] picture, WAV sound files with the same file name as the
@ recording file will be saved. The sounds on channel 1 and 2 will be recorded in “File
Name.WAV”. When the audio mode is set to 4CH, the sounds on channel 3 and 4 will be
recorded in “File Name_sub.WAV”. When using the editing software, load all the sound files.
O The recorded [MPEG2ES] picture cannot be output to the camcorder.
o When [All pictures] or [l picture and P picture] is selected, data dropping ([I] 5-5) may
occeur.
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[Option settings] and [Performance check]

2 Click [Start] on the left side.

The performance check of the hard disk starts.

Performance Check

[Performance check]

You can check whether the selected video folder can be used for saving the recordings before you
start recording on the hard disk.

1 e Set the recording settings and
click [Performance check].

When the [Performance check] button is not
being activated, click the [Apply] button.

* CONSOLE writes the data to the selected folder to evaluate the performance of the hard
disk and graphs out the results every second.

Performance Check

» The performance check takes 30 seconds.
« To cancel the performance check, click [Stop].
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[Option settings] and [Performance check]

3 Click [Start] on the right side. 4 Review the result and click [Close].

The performance check of the system starts. Patformance Chack

Performance Check

R @ O Even if all bars are above the red line after executing the hard disk performance

+ CONSOLE writes the data to the selected folder to evaluate the CPU usage ratio and & check or no data dropping has occurred during the system performance check,
graphs out the results every second; furthermore, it evaluates the occurrences of the data data may be dropped when a program accessing the hard disk (e.g. anti-virus
dropping and the frame rate of the preview. software) is activated.

O A bar below the red line indicates that data may be dropped during recording (a part of
the picture may not be written to the file).

o When recording in HDV standard is selected and data dropping occurs, select a smaller
size at [Preview Resolution] or [I picture only] at [Preview picture] in the [HDV Rec] tab.
([11 3-2) The recording picture will not be affected even if you change the [Preview
resolution] or [Preview picture].

Performance Check

* The performance check takes 30 seconds.
+ To cancel the performance check, click [Stop].

@ o When CONSOLE executes the performance check, the recording data type used for
" writing (DV or HDV) will be according to the recording settings in the [DV Rec] tab.
- When receiving the DV standard data from the camcorder while [Frame] is selected in
the [DV Rec] tab, the writing test of the performance check will not be executed.

The performance check cannot be executed when CONSOLE cannot access to the hard
disc.
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/ Camera and Picture Control

Using the Recording tool to adjust the picture settings of the camcorder to create a picture in the [Rec - . . .
paneg”_ ? ’ ’ ’ P [ Adjusting the Preview Size
The size of the [Rec Viewer] window can be adjusted freely by dragging the edge of the frame with the

mouse. You can also change the size of the preview window with the size option in the right-click

[Rec Viewer]

menu.
: When the preview is in [Full Screen] mode
: - — Rec Viewer (17%) . . ’
Rec Viewer (17%) Iiu 1 click the mouse to return to the previous
& 2 size.
E— 3
Marker SettingsiM). ..
100%:(0)
S0%(H)
- 4 = Full ScreeniF)

@ O The [Rec Viewer] window will be resized according to the specified size or the [Rec

11 — 0001 . kAPE G Panel] size. When [Rec Panel] cannot resize the [Rec Viewer] window according to the
e P specified size, it will be displayed according to the [Rec Panel] size.
L m e O The preview size on the title bar is displayed as a percentage of the preview resolution.
| | | | | | - When previewing HDV data, the percentage will be based on 1920 x 1080 resolution.
10 9 8 7 6 5
1 [Rec Viewer] Displays the camcorder picture.

Right-clicking on the picture allows you to select the size of the
preview panel ([I14-1) and display the overlay markers ([114-2).

2 Audio Monitor Selects the audio channel displayed on the audio level indicator and
Settings adjusts the monitor volume.

3 Audio Monitor Turns ON/OFF the computer’s audio monitor output.

4 Audio Level Indicator  Displays the audio level output from the camcorder. The sound can be
monitored with the computer’s sound system.

5 Zebra Pattern Displays the zebra pattern ([114-5) in the preview.

6 Split Splits the preview ([114-5).

7 Color/Monochrome Switches the preview between color and monochrome display.

8 Interval Counter When [Interval recording] is selected, the remaining interval time is
displayed.

9 Time Code Shows the time code of the file.

10 Recording Indicator The indicator will turn while recording on the hard disk.

11 File Name Displays the file name of the recording file.

When the recording mode is set to HDV, the computer takes a few seconds to display the
camcorder picture in the [Rec Viewer] window.
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/ Camera and Picture Control

—
Overlaying Marker 1 Marker List - Placing a check mark displays the marker on the preview.
You can display the overlaying marker in the preview. The safety zone (90% and 80% of the preview * [+ or [-] that appears next to a marker name indicates that the marker is a
image size), a center, a level and 8 types of aspect markers are predefined as the default markers. group marker which contains several markers in it. Select one of the
markers in the group. Clicking |+ opens the group marker set and clicking
@ When splitting the preview image ([114-5), the markers are not displayed. - closes the displayed marker set, displaying only the group name.
* You can change the name and group that the marker belongs.
m Displaying Overlaying Markers and Settings 2 [Aspect ratio] Selects the aspect ratio of the marker preview.
3 [Marker preview] Displays the marker and allows you to edit it.
1 . . . 4 [Coordinate of T?king the upper left corner as a base.point, the coordinate gf the marker is
Rec Viewer (17%) Right click on the preview and selected marker] displayed as a percentage. You can directly enter the coordinates.
Ll select [Marker Settings] from the 5 [OK] Quits the marker setting, and displays the selected marker in the marker
menu. preview.
Select a marker and click [OK] to display the 6 [UpJ/[Down] Moves the marker name in the marker list.
marker. 7 [Export] Saves the marker.
8 [Import] Adds a new marker in the marker list.
9 [Add] Creates a new marker.
10 [Delete] Deletes a marker.
11 Property The property of the selected marker is displayed. You can change the group
name and the marker name.
1 2 3

Marker Settings ‘

T
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_/ Camera and Picture Control
B Adding a New Marker 4 Select the [Aspect ratio] and click [Add].

1 Click [Add].

[Marker Sattings

2 Select the marker group.

« If the new marker does not belong to any group, select
[Nonel].

« If you want to create a new group, enter the new group
name.

The new marker will be
added; it appears as
selected and will be
displayed in the marker
preview.

[Marker Settings

Cancel

Enter the marker name.

Import
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/ Camera and Picture Control
—
B Editing the Marker B Importing the Marker
1 Select a marker by placing a check mark and click the selected marker 1 click [Import].
name. When a window asking which marker to be imported, specify a marker that you wish to import.
The marker is displayed in the marker preview. WaHRErSStiinas

[Marker Settings

2 Enter the information about the marker and click [OK].
2 Edit the marker by dragging with the mouse and/or entering the + [Marker name] and [Aspect ratio] will be automatically entered according to the file.
coordinates of the marker. « Clicking [OK] imports the marker and displays the newly imported marker in the marker list.

* Drag the frame of the marker to move the marker.
* Drag one of the square marks on the frame to change the marker size.
« Taking the upper left corner as the base point, you can enter the coordinates of the marker

B Deleting the Marker

as a percentage. Clicking [Apply] after entering the coordinates displays the marker at the 1 Select a marker or a group you wish to delete.
specified coordinates.
» The safety zone, center, level and aspect markers cannot be edited. 2 Click [Delete]

* Click [Yes] when a confirmation window is displayed.
* When deleting a group, the group and all the markers in the group will also be deleted.
» The safety zone, center, level and aspect markers cannot be deleted.

B Exporting the Marker

1 Select a marker you wish to save and click [Export].
When a window asking the destination folder and the file name is displayed, specify the
destination folder and the file name.

[Marker Settings
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/ Camera and Picture Control

— . B Changing the Split Settings
Spllttlng the-Preview Image You can change the splitting settings by clicking [ while splitting the preview.
You can split the preview image vertically or horizontally and compare the camcorder picture with

other picture. The splitting function helps you to compare the picture color or brightness with other
picture when you want to adjust or change the settings.

Rec Viewer (17%)

1 Rec Viewer (17%) CI|CK .
; Clicking [[i1]] cancels the splitting.

’_|—1

Position of camera preview

Reference image | —_— 2

Refresh reference camera view —I_

1 Selects the position of the camcorder picture to be displayed.

« You can drag the splitting line on the preview with the mouse to move the splitting line. Se:tgcti;rg [Top] or [Bottom] splits the picture horizontally and [Right] or [Left] splits the picture
,_ vertically.
i 2 Selects the reference picture to be displayed.
[Camera]: Displays a still image captured from the camcorder picture.

[Play Viewer]: Displays the picture that appears in the [Play Viewer] ([116-1).
[Still Image File]: Displays a selected JPEG image.

3 Refreshes the reference image when [Camera] is selected as a reference image.

Zebra Pattern

You can display a zebra pattern on the preview.

1 Rec Viewer (17%) CI|CK .

, 3 * When the camcorder is set to EXT.CONT.
mode, the zebra pattern will be displayed
also in the camcorder screen.

« Clicking [__1] cancels the zebra pattern to
be displayed.

* The mouse cursor will change to \@ on the splitting preview image. By clicking on the
preview image and dragging the mouse, you can reposition the displayed image.

Rec Viewer (17%)

« Clicking @ next to while displaying the zebra pattern on the preview lets you select the
displayed zebra pattern level from the menu.
» The zebra pattern on the preview will not be recorded.
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/ _ Camera and Picture Control

—
[Focus Assist] [Camera Control]
The [Focus Assist] window displays a part of the camcorder picture as in its original size (100%). You This window enables you to control the hard disk recording and set the camcorder settings.
can check the focus of the picture while the reduced size [Rec Viewer] is being used. 1 2
Focus Assist - Aspect correction : 16:9 5|

Camera [Control 5

1 Focus Preview Displays a part of the camcorder picture as in its original size. The mouse
cursor will change to @ on the [Focus Preview] image. By clicking on the
preview image and dragging the mouse, you can reposition the displayed
image.

2 Aspect Ratio Changes the aspect ratio correction mode. When the correction is ON,
the aspect ratio of the image is adjusted by CONSOLE to fit the aspect
ratio of the monitor. The status of the mode will be displayed on the title
bar.

3 Color/Monochrome Switches over the preview to color and monochrome.

1 [Information] Displays the [Information] tab.
2 [Control] Displays the [Control] tab.
3 Finalize When [Sequence] or [Frame] mode is selected in the [Option settings]

window, you can finalize and save the recording file while recording.
4 Start/Stop Recording  Starts/Stops recording onto the hard disk.
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Camera and Picture Control

E[Control] Tab 1 [WHITE B.ALANCF] N o .
You can adjust the white balance by clicking the indicated marks. Placing the mouse cursor on the
ZPN When the camcorder is set to the Camera mode, you cannot control all settings on [Control] panel and right clicking the mouse turns the pointer to the right; left clicking the mouse turns the
“Zd tab. Set the camcorder’s recording program to EXT.CONT. pointer to the left. The panel image differs depending on the camcorder you are connecting. The
screen shots below will be displayed when connecting XL H1.
1 2 3

“amera Contro

Infarmation Coantrol

8 — AESHIFT | WHITE BALANCE—— 1

3 et .i-ﬂﬂ'
- =}
= =
+ X i
F5 By B IE |
+1 +15
4
1 Auto Automated adjustment of the white balance.
7 2
2 . ) Preset 1-2 Adjust the white balance to the preset setting.
1
3 Custom White Balance |While one of the presets is being selected, clicking
3 on this button registers the white balance setting.
For details about saving the white balance settings,
refer to the camcorder instruction manual.
4 n Color Temperature Specifies the color temperature. Clicking [ ] or
[#] increases and decreases the value by 100K.
You can enter a new value by clicking the Kelvin
text box with the mouse and pressing the [Enter]
key on the keyboard. Click the [Enter] key again to
4 apply the new value.
5 Indoor (3200K) Incandescent light.
— 6 Outdoor (5600K) Bright sunlight.
6 T B L {
: — Cption. .. 5 2 [IRIS]
J You can set an aperture value.
i 3 [SHUTTER]

You can set the shutter speed.
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/ Camera and Picture Control

4 [ZOOM]/[FOCUS]

You can control the zooming and focusing functions of the camcorder by moving the slider. The
zoom and focus position moves slowly when the slider is close to the center. When you move the
slider further from its center, the camcorder zoom and focus position will move faster. You can also
adjust the zoom and focus position of the camcorder with the [«] and [—] keys on the keyboard
after clicking the slider with mouse.

2y ° When you are using a manual video lens and selecting [Manual], you cannot control the
" zoom function from CONSOLE.
o When the focus switch of the lens is set to AF, or when you are using a manual video
lens, you cannot adjust the focus function from CONSOLE.
5 [Option settings]
Clicking displays the [Option settings] window.

COption Settings

7 AE Mode

6 :pect ratio; Frame rate; 1
v

5 : Audioreferen al: 2

4 3

Selects a frame rate.

Selects a test tone when displaying the color bars.

Selects a focus speed when operating by keyboard.

Selects a zoom speed when operating by keyboard.

Displays/Hides the color bars.

Selects the aspect ratio when recording in DV.

Nioja A WOIN -

Selects AE mode.

@ The AE mode, aspect ratio and frame rate cannot be changed during the recording.

6 [EXP.LOCK]
Click this button to lock the exposure.

7 [GAIN]
You can adjust the gain level by clicking the scale. Placing the mouse cursor on the panel and right
clicking the mouse turns the pointer to the right; left clicking the mouse turns the pointer to the left.

O The gain level can be set only when the AE mode is set to auto, Tv, Av or manual mode.
@ O When you are using XL2 and set the camcorder’s frame rate to 24F or 30F (NTSC) or
25F (PAL) the camcorder’s gain setting can only go up to +12dB even you set the
CONSOLE'’s gain setting to +18dB.

8 [AE SHIFT]

You can adjust the AE level by clicking the scale. Placing the mouse cursor on the panel and right
clicking the mouse turns the pointer to the right; left clicking the mouse turns the pointer to the left.

@ [AE SHIFT] can be adjusted only when AE mode is set to Auto, Tv or Av mode.
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/ Camera and Picture Control
-
H Displays the recording file name, a recording mode, a file type and the video folder specified
[Information] Tab 1 f f f f
This tab shows information of the hard disk recording. in the [Option] window (LLI3-1).
2 | Displays [Recording history] ((15-5).
= 3 . . : .
Displays the number of data droppings occurred during recording ([115-5).

Camera Control &

- - ) .

Plays back the file selected in [Recording history] ([I15-5).

i Y,

Information >, .~ Contral

Hemaningtme 1 h32m
Hecording mode  Standard mode
File type MPEGZTS

File namne SMSLO0004. MPEG

CNELO0NE MPE

- Dropped data
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/ Camera and Picture Control

1 [Color Picker]
Waveform Vector Monitor The values of selected pixel in [Rec Viewer] are displayed.

This monitor shows a waveform and color information of the picture displayed in the [Rec Viewer]. ! 2 3 4

1 2 3 1 |Displays/Hides the color picker.
2 |Displays the coordinate of the selected pixel.
3 |Displays the color of the selected pixel.
4 |Displays the values of the selected pixel.
Vect|r and Wave Monitor

When the color picker is activated, a marker will be displayed on the preview. You can drag the
Display marker to select a pixel.

. ¥ 174 sl 155N =M. Rec Viewer (17%)
R 237G 17 B 54 :
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/ Camera and Picture Control

2 [Line Select]
You can select the image-scanning mode of the waveform monitor and the vector scope.
1 2

1 |Switches over between the line and full scan mode.

2 |Displays the selected line number.

3 |Selects a number of lines used in the line mode.

A line on the preview will be displayed in the line mode. You can drag up/down the line with the mouse
to select a scan line.

Rec Viewer (17%)

A line for
scanning

3 [Display]
You can display and hide the waveform monitor and the vector scope.
4 Waveform monitor

A waveform of the preview picture is displayed.

5 Scale
You can select the scale of the waveform monitor.
[RE]: -40 IRE - +140 IRE
[Volt 1]: -0.3V — +1.0V
[Volt2]: 0OV - +1.3V

6 [Wave Mode]

You can select the display mode of the waveform monitor. In the PARADE mode, the waveform
monitor will be tri-partitioned.

[Composite]:
[Y1: Displays the luminance signal

Displays a luminance and color-difference signal

[YUV]: Displays the luminance signal, the blue differential signal, and the red differential
signal in PARADE mode.
[RGB]: Displays RGB signals in the PARADE mode in the R, G, B order.

7 Vector scope

Displays the color information of [Rec Viewer]. Depending on the recording standards, the panel
changes automatically.

[Custom Preset]

You can adjust and save the Custom Preset settings. For details, refer to the camcorder instruction
manual.

o Depending on the camcorder connected, some parameters differ. For details, refer to the
@ camcorder instruction manual.
O The [Custom Preset] window cannot be used when recording.
O When using XL2, you need to set the camcorder’s recording program to EXT.CONT.
O When using XL H1, you need to set the camcorder’s recording program to EXT.CONT. to
import and export the Custom Preset files.
When using XL H1, CONSOLE will reset the Custom Preset settings in the following cases.
Save the Custom Preset file on the camcorder memory or memory card, and apply it to the
camcorder.
- Changing the camcorder mode from Camera mode to other mode
- Disconnecting the IEEE 1394 (DV) cable
- Changing the position of the TAPE/CARD switch
- Follow the procedure below to save the Custom Preset file on the Camcorder’s memory or
memory card.
1. Save the Custom Preset file onto the hard disc. ([114-13)
2. Set the Camcorder mode to EXT.CONT.
3. Load the Custom Preset file (saved on the hard disc) to the Camcorder’s memory.
(M 4-12)

4. Save the Custom Preset file on the Camcorder’s memory or memory card. ([1]4-13)

2y © You can change the setting using the keyboard.
& - You can select the next item with the [1] or [Tab] key, and go back to the previous item with
the [1] or [Shift] + [Tab] keys. You can also select items by pressing [2] (down), [4] (left), [6]
(right), and [8] (up) keys.
- The parameters can be changed with the [«] and [—] keys.
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/ Camera and Picture Control

Importing the Custom Preset

CONSOLE imports the Custom Preset file in the camcorder or the hard disk and applies to the
camcorder.

1 Custom Preset Click @I
=

[EREFT]
B Gain

Caring

HOTL FREQ
W Detail
Color Matrix

Gamma

iz
[ -
G-F Matrix B-G Matrix

Select a Custom Preset file.
* When importing a Custom Preset file from the camcorder, select .
* When importing a Custom Preset file from the card, select .

- When selecting , you cannot import Custom Preset files that were recorded separately
when recording on a tape. To import such Custom Preset files, first copy them to the hard
disk and import the file from the hard disk. ([116-3)

* When importing a Custom Preset file from the hard disk, select .

- Selecting displays a list of the recently imported and saved files. You can select a file
from the list. Click [=] to select a file that is not in the list.
llmpon The information of the selected Custom Preset

setting is displayed, and the settings are applied to
the camcorder only to preview the picture. The
camcorder settings have not been set yet.

Check the camcorder picture and the settings, and click [OK].

Clicking [Cancel] stops importing the file and returns the camcorder setting to the previous
setting.
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_/ Camera and Picture Control
Exportingthe-Custom Preset 2 Select a destination to export the file.

You can save the current camcorder setting as a Custom Preset file.

1

The information of the selected Custom Preset setting
is displayed and the settings are applied to the
camcorder only to preview the picture.The camcorder
settings have not been set yet.

Click =

Custom Preset

G Gain

B Gain

Coring

DTL HASBA

HOTL FREQ
W Detail
Color Matrix

Gamma

« Select the preset number you wish to export when selecting or .
* When selecting , specify a file name to be saved.
- Select a file from a list of the recently exported and saved files. If you wish to export a file

E-G Matiix that is not in the list, click [--] and select a file.

=t

3 Check the camcorder picture and the settings, and click [OK].

4 Input a preset name, specify the protect mode and click [OK].
* When a confirmation window appears, click [OK].
» The Custom Preset file will be saved, and the camcorder settings will be set to the saved
Custom Preset file setting.
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/ Camera and Picture Control

Preset Variation

Clicking on [gzEEEg displays the [Variation] window. The [Variation] window shows still images
captured from the camcorder picture with different parameters in order to contrast the current settings
with alternative settings.

Variatio|

1 [Display mode] Selects the display mode of the current and candidate images.

[Fit]: Resizes the still image so the whole image will be

displayed in a frame.

Displays the still image without adjusting its size. To specify

which part in the image to be displayed, click

specify an area to be displayed in the [Position] window.

Specifies the variation level. Clicking redisplays the images in the

specified level.

Specifies the reference image to be displayed.

[Original): Applies the same settings as the current image.

[Image File]:  Displays a selected still image file.

[Play Viewer]: Displays a captured still image of the displayed picture in
the [Play Viewer] window ([116-1).

Displays the current Custom Preset setting. Placing the mouse cursor on

the candidate image highlights the corresponding setting. You can close

the window by clicking the button again.

Still images with the different Custom Preset settings. Clicking one of the

images makes CONSOLE to apply the settings of the selected image to

the camcorder, and refreshes the window.

A still image captured with the current Custom Preset settings.

[Clip]:

2 [Level]

3 [Reference]
setting

4 [Settings]

5 Candidates

6 [Current]

7 [Cancel] Closes the [Variation] window. The setting of the camcorder returns to
original settings.
8 [OK] Closes the [Variation] window.

9 [Reference]
10 Category

A still reference image.
Tabs of different categories of the Custom Preset settings.

O When displaying the [Variation] window for the first time in DV and HDV mode, the color

4 bars will be displayed on the camcorder screen.

O The images used for the candidate are not the same images. Each of the images is
captured separately by the camcorder. When using the [Variation] window, it is
recommended to shoot a still object.

Resetting the Custom Preset

Clicking resets the current settings.
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) Recording onto the Hard Disk

O The time limits for recording to a single file depends on the settings of the camcorder and
CONSOLE. When the recording reaches the time limit recording pauses and then starts
again automatically in a new file. However, there will be some scenes that are not recorded
during the interval when recording stops and then restarts in the new file.

You can record video and audio from a connected camcorder on the hard disk of the computer by
operating the camcorder or the recording panel of CONSOLE.

@ O Before you start recording:
- If you set the video folder to an external hard disk, an error message “Delayed Write

Failed” may be displayed while recording onto the hard disk, and the recording may be Creating WAV Camcorder’s Audio Settings
lost. audio file for

- Make a performance check ([I1 3-3) to make sure that the recording can be saved to the Standard File Type CH3/4 when 2CH ACH
selected video folder. audio mode is 4

- Make sure that [[[[fJel] is displayed on the camcorder screen. If [[I§2———] or [z ] channels
is displayed, you cannot record on the hard disk. In such case, check the setting of the o 4 hours
video folder (( Tr-2). AVI-Typef Checked Not Limited 30 minutes

- Whgn magnifying the viewﬂnder image by p.r(.assing the EVF MAGNIFYING button, the DV AVI-Type2 Unchecked Not Limited Not Limited
beginning of the recorded file may be magnified as well. When you are using the frame
recording function, the recorded frame-by-frame image will be magnified when enlarging MXE Checked 3 hours 3 hours
the viewfinder image. Deactivate the magnifying viewfinder before you start the recording. Unchecked 3 hours 3 hours

- We regommend defragmenting the drive on wh_ich the video folder_is located. - VPEGTS Checked Not Limited 3 hours

- Deactivate all programs that access the hard disk on a regular basis (e.g_. as an_tl-wrus Unchecked Not Limited Not Limited
software). Data may be dropped when such programs access the hard disk during HDV
recording Checked 3 hours 3 hours

e I . . MPEG2ES
- If you wish to edit using the time code, make sure to record simultaneously on a tape. The Unchecked 3 hours 3 hours

time code information will only be written to the hard disk when recording on a tape. The
time code will not be written in the cache recording part ([11 5-3).
O In the following cases, recordings cannot be saved on a hard disk:

- During option settings or performance check.

- When the sequence number of the file exceeds the maximum value (e.g.
“CNSL9999999.avi”).

- When CONSOLE is started while using the camcorder with another software.

O Observe the followings during recording:

- Do not activate any other software. When another software is running, data droppings
may occur. Also, when software that accesses the camcorder (e.g. editing software) is
started, CONSOLE may not operate correctly.

- Do not change the settings in Windows [Display Properties] window.

- Do not lock Windows by pressing the Windows key and [L] key on the keyboard.

- When the computer shuts down or enters stand-by mode due to the running out of the
battery, the recording file may be corrupted and/or may not be played back.

o Depending on the status of the camcorder or computer, a delay in recording start/stop may
occur when you record on both the hard disk and tape.

o When you start recording simultaneously on the tape and the hard disc, the recording on the
hard disc will start approximately one second later.
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',' | Recording onto the Hard Disk

Recording a Movie File

By Operating the Camcorder

Press the start/stop button on the camcorder.

» Recording starts on both the tape in the camcorder and the hard disk.

* When [Save custom preset file when recording start] is selected in the [General] tab setting,
the Custom Preset file will be saved in the same folder as the video folder. The name of the
Custom Preset file is the same as the recording file name.

+ [[%2,®] appears on the camcorder screen.

* When no tape is inserted, or the tape is write-protected, recording is saved only on the hard
disk.

« Even when the tape reaches the end, recording onto the hard disk continues.

« To stop recording, press the start/stop button on the camcorder again.

By Operating CONSOLE

[ | Click B in the [Camera Control]

Infarmati

AESHIFT

-1
2.eve 05

o=
+2%. o Sae

+1

Option...

[Option settings] and [Performance check] :.:amera and Picture Control = Recording onto the Hard Disk = Playback the Recorded Files ﬁ

» Recording starts on both the tape in the camcorder and the hard disk.

* When [Save custom preset file when recording start] is selected in the [General] tab setting,
the Custom Preset file will be saved in the same folder as the video folder. The name of the
Custom Preset file is the same as the recording file name.

- A changes to (LI, and the recording indicator in the [Rec Viewer] window
starts rotating.

* When no tape is inserted, or the tape is write-protected, recording is saved only on the hard
disk.

« Even when the tape reaches the end, recording onto the hard disk continues. When you
restart the recording by pressing the camcorder’s start/stop button after changing the tape,
the camcorder will start to record on the tape, and CONSOLE will keep recording onto the
hard disk.

* When recording in HDV standard on the tape and hard disk, a new file will be created after
changing the tape when you restart the recording by pressing the camcorder’s Start/Stop
button. The computer stops the recording and restarts recording onto the new file.

« To record the next scene as another file in [Sequence] or [Frame] mode, finalize the file by
clicking in recording or when recording is stopped.

o When the frame rate was changed during recording, recording stops, and a new file will be
& created when recording is resumed.
O When using a laptop computer, the recording will not stop even if the display is closed.p
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Cache Recording

You can set CONSOLE to store the camcorder picture before recording. When you start recording,
the last 10 seconds previous to the recording start are also recorded in the file. By using the cache
recording, you can reduce the chances of missing the beginning of important scenes.

When you start a simultaneous recording while receiving the HDV standard signal, the cache
recording cannot be performed.

Setting the Cache Time

1 Select [Option] from the [File] menu
CONSOLE or click #.

Wiew(h)  Wersion(I)

i@& RIS

Excit(#)

=1 IELC Fammety

Custom Preset

Select [General] tab, and set the
cache time.
* You can select from “0 Sec.” to “10 Sec.”.

« Selecting “0 Sec.” disables the cache recording
function.

Option Settings

3 click [OK].

@ o When recording in DV and [Recording mode] is set to [Frame], the cache recording function
“Z4 s disabled.
o When recording in HDV, the cache recording time is actually longer than the time set.
O The cache recording data is cleared in the following cases:
- When the frame rate is changed.
- When the sound recording mode is changed.
- When the recording mode is switched from E)(()LT to one of the other modes or from any
other mode to (g -
- When the recording standard is changed.
- When IEEE1394 (DV) is disconnected or reconnected.

Cache Recording

1 Set the cache time. (O 5-3)

If you close CONSOLE after setting the cache time, the cache recording will begin
automatically the next time you start the software.

2 Start the recording. ([115-2)
* CONSOLE records the cached picture and the camcorder picture onto the hard disk.
» The cached picture will not be recorded on the tape.
* When the recording is stopped, CONSOLE starts the cache recording again.
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. Frame Recording
Frame Recording

You can record frame by frame in the same file. This function enables you to easily create a stop 1 Specify the frame recording settings. ([115-4)
motion animation movie.

O When recording in HDV or setting the frame rate to 24F, the frame recording function cannot 2
@ be used.
o [y ——] will be displayed in the camcorder screen; however, the frame recording 5 ——
cannot be controlled from the camcorder. e

Click (S in the [Camera
Control] window.

| WWHITE BALANCE

Setting the Frame Recording

1 — Select [Option] from the [File] menu
CONSOLE or click #.

Wiew(h  Yersion(I)
|~ IRIS

e GIE o

Exit{)
=T e Fanren

BR00

| SHUTTER
1480

Custom Preset

2 TR Select [DV Rec] tab and select
o . [Frame] as the recording mode.
When [Interval recording] is checked, CONSOLE
repeatedly records the frame image at the | BEXPLOCK
specified interval time. — Optior..

* CONSOLE records onto the hard disk only. You cannot record on the tape when you are
recording frame by frame.

» When [Interval recording] is selected in the [Option settings] window, (Sl changes to
B . and clicking [T pauses the recording.

» When [Interval recording] is selected, the remaining time will be displayed in [Rec Viewer].

« If you want to record the next scene to a different file, click (=2l to finalize the file.

» While T is appearing, clicking (=2l stops the interval recording. To restart the

interval recording, click (NS -

MEAR

File type:

Cancel

3 cClick [OK].




CONSOLE WindowsJ [Option settings] and [Performance check] .Camera and Picture Control  Recording onto the Hard Disk = Playback the Recorded Files ﬁ

—lf

Recording onto the Hard Disk

Data Dropping Recording History

* When a program accesses the hard disk during recording, a part of the data input from the When you stop recording the picture in [Standard] mode, or when a file is created after finalizing in
camcorder may not be written to the file (data dropping). This may happen also when the processing [Sequence] or [Frame] mode, the created file information will be displayed under [Recording history]
capacity of the computer is insufficient. in the [Camera Control] window.

» When the data dropping occurs, the number of data droppings occurred in a file will be displayed in
the [Information] tab of the [Camera Control] window. When recording in DV, a number of dropped @ The recording history will disappear when you close CONSOLE. When you wish to review the
frames and when recording in HDV, a number of dropped blocks are displayed. Dropping one block history after you have closed CONSOLE, open the “CONSOLE.LOG” file in the video folder
in HDV recording corresponds to dropping from a few frames to up to 20 frames in DV recording. with a text editor. You can check the file name, recording date, file size, length, file type, and

+ When the data dropping occurs, [[iffz2y®] changes to [[[ffzx0] for a few seconds. the information about dropped data.

» When the file is created on the hard disk after recording, you can check the scenes where data
dropping occurred under [Recording history].

CHEL000Z. MPEG
M= L0003 MPEG

Dropped data

1 File name Shows the file name recorded with CONSOLE. The file information appears
when you leave the mouse pointer on the file name for a moment.

2 Information on  If data dropping occurred, the position and number of dropped data are
dropped data shown here.

3 Playback When a file name is selected: Clicking i@ starts the playback panel and
the file is played back from the beginning.

When information on dropped data is selected: Clicking (@& plays back the
file in the [Play Viewer] window from the point where the data dropping
occurred.
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U Playback the Recorded Files

You can playback or view the recorded pictures using playback tools in [Play Panel].
1 Playback Preview Displays the played back pictures selected in the [File Browser] window.

. Right clicking on the preview window allows you to select the size of the
[Play Viewer] gnt eleting P , Y
preview panel ([I14-1) and to display the overlay markers ([114-2).
You can playback and preview the recorded files. 2 Audio Monitor Set- Selects which audio channel to be displayed on the audio level indicator
2 When the preview image is not smoothly played back, the playing back condition of the image tlngs' : 2t EGJUES e TEET L. . i
“Z4 may be improved by hiding the [Rec Panel] or [Rec Viewer], not displaying the camcorder 3 Audio Monitor Turns ON/OFF the computer’s audio monitor output.
picture. 4 Audio Level Indi- Displays the audio level of the playback file.The sound can be monitored
1 cator with the computer’s sound system.
| 5 Time Slider Allows you to change the playback position.

- - 6 Special Playback Specifies the playback speed (Special Playback Modes). There is no
Play Viewer {17%)

Modes sound during special playback. The special playback modes can be
5 applied to fast-forwarding only.
DV/HDV: 1/3, 1/2.5, 1/2, 1x, 2x, 4x
— 3 7 Output Displays the playback images on the camcorder screen.
8 =/um Plays/Pauses the playback file. When you pause the file, click @@ to
restart the playback.
9 Time Code Shows the playback position of the file.
Ly 10 File Name Displays the playback file name.

You cannot monitor the sound on channel 3 and 4 when playing back a MPEG2ES recorded in
HDV.

Q0004
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Playback the Recorded Files

Output to the Camcorder

By connecting the camcorder to the monitor, you can output the recorded pictures from the computer
to the monitor.

®

—_— ——
—

O To output the playback pictures to the camcorder, you need to set the camcorder’s
recording program to EXT.CONT.
O When using XL H1:
If you select the HDV mode, only video in HDV standard is displayed on the monitor; if you
select the SD mode, only video in DV standard is displayed on the monitor.
When using XL2:
Only video in DV standard is displayed on the monitor.
O The camcorder’s SDI terminal cannot be used for outputting pictures from CONSOLE.
O When setting the camcorder to EXT.CONT. the following limitations apply to CONSOLE.
- Unable to use the special playback modes.
- The sound cannot be monitored with the computer's sound system.
- When pausing the playback, no image is displayed on the monitor.
- Unable to playback MPEG2ES picture.
- Unable to record pictures.

Click g in the [Play Viewer] window.

* CONSOLE changes its mode to the output mode, and the camcorder will be set to the
receiving mode.

» While the camcorder is set to the receiving mode, recording cannot be performed.

Select a file in [File Browser] (11 6-3).

Click @2 or double-click the selected file in [File Browser].

* The playback file is displayed in [Playback Viewer] and the camcorder.

« Clicking (il pauses the playback. Clicking [ restarts the playback.

* A few frames will not be displayed when you pause and restart the HDV standard file.
* Clicking ﬁ returns the camcorder mode to the recording mode.

CONSOLE WindowsJ [Option settings] and [Performance check] lCamera and Picture Control = Recording onto the Hard Disk = Playback the Recorded Files m

Time Slider
You can change the playback position by dragging the slider with the mouse.
1 2 3 4

oo:00:01

LILELR

oo:00:04

Slider

The slider returns to the starting point.

The slider moves to the data dropping point after the current position.
Change the time slider scale.

A ODN =

» Data droppings that occurred during recording are indicated in red.
- By clicking (@, the slider moves to the next data dropping point after the current position. By
clicking I, the slider moves to the previous data dropping point before the current position.

—

= =
1 o

i W

00:00:45 00:00: 00:00:47 Q0:00:48

00:00:44

O While pausing the playback picture, pressing the [«] or [] key on the keyboard after

' moving the slider with the mouse allows you to finely adjust the position of the slider.

- When adjusting the position of the playback picture of an HDV recording with the [«] or
[—] key, you cannot adjust the picture frame by frame.
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U Playback the Recorded Files

File Browser

In the file browser, the files stored in the hard disk are displayed.

File Browser

& ]

| : File typs

1 Selects the display pattern. You can select to display only the thumbnails or the thumbnails
with the file information.

Selects the display order of the files.
Copies from the memory card ([116-3).
Refreshes the files displayed in the window.

Displays the files in the selected folder.
Double-clicking a file, the selected file will be played back in [Play Viewer].

6 Displays the explorer view.

a b WODN

2y © Placing the cursor over a file for a few seconds will display the file information.
“Z4 o Files recorded in 24F mode are marked with (NTSC only).
O To delete a file, right-click the thumbnail and select [Delete] from the displayed menu.
B8 will be attached to the thumbnails of all Custom Preset files. By right clicking on the
thumbnail, you can check the settings of the Custom Preset and can load the Custom
Preset file to the camcorder.

Copying from the Memory Card
You can copy the still image and the Custom Preset files from the memory card to the hard disk.

o When using XL2, you cannot use a memory card.
@ O When using XL H1, you need to set the camcorder’s recording program to EXT.CONT.
O Proper operation cannot be guaranteed if you are not using Canon camcorders to create the
image files.

1 File Browser

Click [[B).
The thumbnails of still image files and the
Custom Preset files are displayed.

2 St Select a file you wish to copy.

BF is attached to the thumbnails of the still image files that have the corresponding Custom
Preset files that were recorded in the separate file at the same time when the images were
recorded.
- When selecting a still image with [EF
copied.
* By clicking [Select All] selects all files in the card.
« By clicking [Show Custom Preset file only] displays the Custom Preset files only.

, the still image and its Custom Preset file also are

3 click [OK].

4 select a folder for storing the copied file.
To cancel the copying, click [Cancel].

Waveform Vector Monitor

A waveform of the playback picture and the color information are displayed. The functions are the
same as the waveform vector monitor ([1] 4-10) of [Rec Panel].
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Uninstall

Uninstalling the Software

Uninstall the software if it has not been installed correctly, or if it is not required anymore.

@ O Close any programs that are running, and disconnect the IEEE1394 (DV) cable from the
camcorder and the computer before uninstalling the software.
O You need to log in as an administrator before uninstalling the software

1 From the [start] menu, select [All Programs] followed by [Canon
Utilities], [CONSOLE] and [CONSOLE Uninstall].

/2% mnternet My Documents
Tnternek Explorer

i B e
Cutlock Express || W8 Windows Catalog
@ windows Update
‘,‘g Faint
) Acce: r

@W\nduwsMuwel 2 x B consoLe 1.0
1) Games e @ CONSOLE Lninstal

\’ 1SN Explorer 1) Startup »
@) virtusl FC Additions
e Windows Meda Play

B tnterne: Explorer I
) MM Explorer
m@ Tourwindows || 8 "
9) outiook Express
o Remate Assistance
& windows Media Player

Windows Messenger

On the confirmation dialog, click
[OK].

Do you want ko completely remove the selected application and all of its features?

On the confirmation dialog, click
[Finish].

InstallShield Wizard

InstallS hield Wizard Complete
J

Uninstalltion has completed.

Uninstalling the AV/C Camera Storage Subunit-WIA Driver

Uninstall the AV/C Camera Storage Subunit-WIA driver if it has not been installed correctly or if it is
not required anymore.

@ O Close all programs that are running before uninstalling the driver.
O You need to log in as an administrator before uninstalling the driver.

1 Turn the camcorder power on and set the camcorder’s recording
program to EXT.CONT.

2 Connect the camcorder to the computer using the IEEE1394 (DV)
cable.
If Scanner and Camera Wizard or Explorer is displayed, close the windows.

3 From the [start] menu, select [Control Panel].

& : — @) Click [Printers and Other
7 P Hardware].

? FOT—— Date T, Langusge, and Regional

1(2)) Sounds,Speceh, and Audo Devices Accessibity Options

@Y Performance and Maintenance |/ Security Center

Click [Scanners and Cameras].
If you cannot find the [Scanners and

Cameras] icon, see Uninstalling of the
Drivers ([17-2).

C O B P s |

2 Prvers n —

Pick a task...
[3) View installed printers or fax printers

(3] Add aprinter

or pick a Control Panel icon




Uninstall

Right-click the [Canon Camera
Storage Device] icon and select
[Delete].

When the icon does not appear, see
Uninstalling of the Drivers ([I17-2).

Uninstalling of the Drivers
If you had problems uninstalling the driver, use the following procedures to remove it.

2y ° Use the procedures below for the following circumstances too.
' - If you do not find the [Scanners and Cameras] icon in the [Printers and Other Hardware].
- If the Camera icon does not appear in the [Scanners and Cameras] folder.

1 From the [start] menu, select [Control Panel].

In the confirmation dialog, click [Yes].

* [#(number)] may appear after [Canon Camera Storage Device], but that would not affect the
uninstall process.

» The uninstall process is complete.

Click [Performance and
Maintenance].

Favortes Tools telp

F Osewen [ roes | [

Click [System].

o

E
Ok O 3| Psst roces |-

ard diskc to make programs run faster.

or pick a Control Panel icon

B scnctuearasts

4 Click the [Hardware] tab on the [System Properties].
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Uninstall

Click the [Device Manager] button.

System Restore Automatic Updates Remote
General Computer Name || Hadware Advanced

Device Manager

=&=0  The Device Manager lists all the hardware devices installed
oh your computer, Use the Device Manager to change the
properties of any device.

[ DeviosManager |

Diivers

@ Driver Signing lets you make sure that installed drivers are
compatible with Windows. Windaws Update lets you set up
how Windows connects to Windows Update for drivers.

[ Driver Signing ] l ‘windows LUpdate

Harduware Profiles

Hardware profiles provide & way for you ta set up and store
different hardware configurations.

Hardware Frofiles

If [Canon Camera Storage Device] appears under the [Imaging
devices] and/or [Other devices] categories, use the following

procedures to delete it.

1) Right click on [Canon Camera Storage Device] and select [Uninstall] from the menu.

5 Device Manager
File Adion Vew Help
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selected device,

2) In the confirmation dialog, click [OK] and close [System Properties] and [Device
Manager]. Remove all copies of the [Canon Camera Storage Device] icon that appear in
the [Other devices] or [Imaging devices] categories, or that appear more than once in one

category.

Confirm Device Removal

:@ Canon Camera Storage Device

Warning: ou are about to uninstall this device from your sestem,

7 From the [start] menu, select [My Computer] and double-click the [C:]

(local disk), [WINDOWS] and [INF] folders in succession.

> S ook [ oo [ ] v

« If the [INF] folder is not visible in the [WINDOWS] folder, use the following procedures to

show all files and folders.

1) Click the [Tools] menu and select [Folder Options].

2) Click the [View] tab.

3) In the [Advanced settings] section, set the [Hidden files and folders] category to the

[Show hidden files and folders] option.

Map Metwork Drive, |,
Disconnect Metwark Drive, .
Swnchronize. .,

kions. ..

Folder Options E

General | View | File Types | Offine Files

Folder views
You can apply the view (such s Details o Ties] that

you are using for this foldr 1o ol folders.
[ poly to Al Folders_| [ Reset &l Folders

Advanced seftings
] Display the contents of system folders P
Display the full path in the address bar |
[ Display the ful path in the tile bar
[ Do mot esche thumbraik:

() Hidden files and fciders
oD i

O]
Hid
Hide protected operating system files (Aecommended)
[ Laurnch falder windows in a separste process
Fiemember sach folder's view seitings

[ Fiestore previous folder vindaws ot lagan ~|
Fiestore Delaults
[ ok J[ careel [ gpek |

« If [Hide extensions for known file types] is selected, remove its check mark.



Uninstall

8 Double-click the [oem*.INF] file.

* A number such as “0” or “1” appears in place of the asterisk (*) above. You will also find
another file called [oem*.PNF], which will have the same number as the [oem*.INF] file. The
two constitute one set. There may be many file sets starting with “oem”.

Fle Edt Vew Favortes Tods Heb L
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s [© CwbOwSIE >
Name See Type Date Modfied ]
File and Folder Tasks (&)l [Somme.pre 10516 Precompied St 3212005525 P
A Soen? 26 Satp rfomation 812004 75557
L Bloenrore 7K0 Preconpled Setup... S/2I20050:27 it
(y Move this il Toems 4KB SetvpInfomation  /11/2004 7:55 P
D) copythstie Bomarme S0 Proconpled Setup... 312120059127 it
@) PublishthisF tothe Vieb Boems 126K8 Setup Information  1/26{2005 3:41 AM
8 emaitiatie Bomane 18K reccapledSetup .. 3202008 801 i
o 20 Satp Ifomation 41202008 L4370
50 Proconpled SeupL... S/IS(2005 34370
2 SLEEIELS 12X Setup nfomation 7/120055105 At
12K Precompled Setup ... 9/15/2005 3:43 PM
Other Places 7KB  Setup Information 8/4/2004 5:00 AM
(8 oobe.Pr 17K Precomplled Setup ... 1/2/2005 11:45 AM
& wmoows optional KB SetupIormatin /412004 5:00 A
@ v vocuments [Sloptonalene 22KB Precompled Setup... 9/2/20058:23PH
= ovcam 156 Setpfomation 54200451000
& oveam.PHF 25KB Precompied Setup1... 1/2/2005 11:45 AM
§ b Conpuec Sovcomp 2B SetupInformation 8/4/20045:00 A
8ty Network laces [Sloveomp.pre 6KB Precompled Seup ... 1/2/2005 11145 A
Sovsond 60 Setplrfomaton SIS0
% | Dovsonsrne 15K Procanpied Setup .. 1122005 11145 A0
Detali N ez 7KB Setup Information  8/4/2004 5100 A
Bezorne 14K Precampied Seup .. 924200552951
Tpunse 140 Setup normation 8472004 5100 0
[Slparhmse.pre 35KB_Precompled Setupl... _1/2/2005 1145 AM )

have found the correct file, delete the file

The Windows Notepad program will start and show the file contents.

When uninstalling the AV/C Camera Storage Subunit-WIA Driver, click each [oem*] file until
you find the one that contains [; AV/C Camera Storage WIA driver] in its first line. When you

set.

7 AV/C Camera Storage WIA driver
Copyright (c) 2008 Canon Inc.

This section is mandatory for all INF Files

Tversion]

[sour cevisksnames . x86]
1=XINST_DISKE, ,,

[Saur cevisksFiles]
Fomind. d11=
< |

accskmd. sys=:
FCExtend, d11=1
i 1

Signature="§CHICAGOS "
C1as5-Image ; Indicates the setup class
C1355GUTD={ 61 F6-810F-11d0-bec7-08002be2092F} } GUID of the setup class
Provi der=xCanon Name OF the INF file provide
catalogrile=Canoncs, cat } Name of the catalog file
brfverver-07,/06,2005,1.4 i oriver versian
[controlrlags]
Excluderromselact=x 3 a1 prp devices should be excluded from manual Addbevice app
[Manufacturer]

anank=Canon ; The manufacturer of Cs target is Canon

1) Close the Notepad window.

2) Right-click the mouse button and select [Delete].
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2K Setup Information
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K6 Setup Information
13K6 Precompled Setup 1.
7K8 Setup Information
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14K8 Setup Information
parhise. PN 35K8 Precompled Setup 1.

Properties

v B
Date Madfied &
9/2/2005 8:25 P11
8/11/2004 7:55 Pi0
9212005 8:27 P11
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1§26(2005 3:41 A0
9/2/2005 8:31 P11
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8/4/2004 5:00 At
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8/4/2004 5:00 Al
9/2/2005 8:23 P11
8/4/2004 5:00 A1
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8/4/2004 5:00 Al
1212005 11:45 A1
8/4/2004 5:00 Al
1122005 11:45 A
8/4/2004 5:00 At
92/2005 8:23 P11
8/4/2004 5:00 Al

112j2005 145449

9 Close all windows and restart the computer.

The [INF] folder contains numerous files that are critical to the computer’s operation. Be
extremely careful not to delete the wrong files. If you delete the wrong file, you may be
unable to restart Windows.



Troubleshooting

Cannot launch CONSOLE.

= [Hardware acceleration] of your computer is not set to [Full].
1) Open the [Control Panel] window and display the [Display Properties] window by clicking
the [Appearance and Themes] icon followed by the [Display] icon.
2) Click the [Setting] tab and the [Advanced] button.
3) Click the [Troubleshoot] tab and adjust the [Hardware acceleration] slider to [Full]. Then
click [OK].
= CONSOLE may not be launched if movie playback software or video editing software is already
running. You need to close the software and try to launch CONSOLE.

Camcorder will not be recognized or controlled.

= A camcorder not supported by CONSOLE is connected. Check if your camcorder is supported
by CONSOLE ([IJiii).

= The DV CONTROL function of the camcorder is set to [OFF]. Set the DV CONTROL function to
[ON]. For details, refer to the instruction manual of your camcorder.

= More than one camcorder is connected to the computer’s IEEE1394 (DV) terminal. Connect
only one camcorder to the computer’s IEEE1394 (DV) terminal.

= |f your computer has an IEEE1394 (DV) board/card in addition to the standard IEEE1394 (DV)
board/card, or if you have more than 2 IEEE1394 (DV) boards/cards added to the computer, the
computer may not recognize the camcorder properly. You need to plug the IEEE1394 (DV)
cable to a different board's/card's terminal.
To check if the cable is properly connected, follow the instructions below.
1) Open the [Device Manager] window. ([117-2)
2) Select [Devices by connection] from the [View] menu.
3) Look for the IEEE1394 controller with [Canon Virtual VCR].

4) Confirm that [AV/C Tape Device] or [Canon DV Camcorder] is connected.

Ep Device Manager E@
File  Action  Wiew Help
€ 2 a
=2 CONSOLE ~
=1 4§ ACPI Uniprocessor PC
| vg Microsoft ACPI-Cormpliant Syskem
8 Intel(R) Pentium(R) 4 processor
i Matherboard resources
=% PCIbus
=1 % Intel(R) &2801 PCI Bridge - 2445
—|- &g OHCI Compliant IEEE 1394 Host Controller
3 1394 Net Adapter
@, AVIT Tape Device
248 Canon Camera Storage Device
=4 Canon Yirkual YR v
< >

Even though the dedicated driver (Canon Virtual VCR or AV/C Tape Recorder/Player) is
installed already, the [Found New Hardware Wizard] window appears when starting
CONSOLE.
= When you change the computer’s IEEE1394 (DV) card and start CONSOLE, Canon Virtual

VCR or AV/C Tape Recorder/Player will be detected as new hardware. Select [Install the
software automatically (Recommended)] and click [Next] to install the driver.

Cannot select a video folder.
= Only folders on a NTFS formatted hard disks can be selected as a video folder. You cannot
select a folder on FAT32 or FAT16 hard disks.
= Removable disks or network drives cannot be selected as a video folder.



Troubleshooting

Recording will not start even when pressing the start/stop button on the camcorder.

= The start/stop button on the camcorder is locked. Unlock the button.

2> When using XL H1: If you connect 4 or more devices (including the connected computer and
the XL H1 itself) by IEEE1394 or if the XL H1 and 1 or more other video devices are connected
to the computer by IEEE1394, recording onto the hard disk cannot be started by pressing the
camcorder’s start/stop button.

2> When using XL2: If the XL2 and 1 or more other devices are connected to the computer by
IEEE1394, recording onto the hard disk cannot be started by pressing the camcorder’s start/
stop button.

[[%72,——] appears on the camcorder screen and recordings cannot be made.

= Available hard disk space on the drive where the video folder is saved is less than 0.5 GB.
Change the drive or delete some files to free more disk space.

= The [Option Settings] window is open, or performance check is being carried out. Close the
window.

= The sequence number of the file exceeds the maximum value (e.g. “DVPC9999999.avi").
Change the video folder or the file name.

= The camcorder is in use with another software. Close the software.

= The camcorder does not recognize CONSOLE. Close CONSOLE and restart it.

Recording on the hard disk stops in the middle of the recording.
= The hard disk capacity is insufficient. Delete files to make space available, or select a video
folder on a hard disk with sufficient capacity.

The recorded picture is lacking.
= The recording speed of the hard disk is insufficient. Make a performance check ([ 3-3). We
recommend defragmenting the drive before you start recording.
= A program other than CONSOLE is started. Close all programs other than CONSOLE before
recording. If an anti-virus software is activated, deactivate it.
= The processing capacity of your computer is insufficient. Reduce the size of [Rec Viewer] or
hide it.

The preview image is not played back smoothly.
= Depending on the laptop PC’s power scheme settings that control the CPU operations, the
preview image may not be played back smoothly. Follow the procedure below to change the
power scheme settings.
1) Open [Control Panel] and click [Performance and Maintenance].
2) Click [Power Options] and the [Power Options Properties] window will be displayed.
3) Select the [Power Schemes] tab and select [Always On] in [Power schemes].




Appendix

Shortcut Keys

B Displaying [Rec Panel]: [7]
Changing the tools in [Rec Panel]: [+]

B Displaying [Play Panel]: [9]
Changing the tools in [Play Panel]: [+]

B [Camera Control]

Start/Stop recording: [0]
Finalize: [.]
Displaying the [Control] tab: [*]
Displaying the [Information] tab: [/]
Switching the setting item

Next: [{], [Tab]

Previous: [1], [Shift] + [Tab]

Up: [8]

Down: [2]

Right: [6]

Left: [4]

Setting the level:[+], [—]

B [Custom Preset]

Switching the setting item
Next: [4], [Tab]
Previous: [1], [Shift] + [Tab]
Up: [8]
Down: [2]
Right: [6]
Left: [4]
Moving the slider
Increase: [—]
Decrease: [«]
Changing items in the pull down menu
Up: [1]
Down: [{]

H [Play Viewer]
Start/Stop Playback: [0]
® Full Screen: [F12]
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